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Communications regulation information

FCC statement
This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. See instructions if interference to
radio or television reception is suspected.

Radio and television interference
The equipment described in this manual generates, uses, and can radiate radio-frequency
energy. If it is not installed and used properly—that is, in strict accordance with Apple’s
instructions—it may cause interference with radio and television reception.

This equipment has been tested and found to comply with the limits for a Class B digital device
in accordance with the specifications in Part 15 of FCC rules. These specifications are designed
to provide reasonable protection against such interference in a residential installation. However,
there is no guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by turning it off. If
the interference stops, it was probably caused by the computer or one of the peripheral devices.

If your computer system does cause interference to radio or television reception, try to correct
the interference by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops.
m Move the computer to one side or the other of the television or radio.
m Move the computer farther away from the television or radio.
m Plug the computer into an outlet that is on a different circuit from the television or radio.

(That is, make certain the computer and the television or radio are on circuits controlled by
different circuit breakers or fuses.)

If necessary, consult an Apple-authorized service provider or Apple. See the service and support
information that came with your Apple product. Or, consult an experienced radio/television
technician for additional suggestions. You may find the following booklet helpful: Interference
Handbook (stock number 004-000-00493-1). This booklet, prepared by the Federal
Communications Commission, is available from the U.S. Government Printing Office,
Washington, DC 20402.

IMPORTANT Changes or modifications to this product not authorized by Apple Computer, Inc.,
could void the FCC Certification and negate your authority to operate the product.

This product was tested for FCC compliance under conditions that included the use of Apple
peripheral devices and Apple shielded cables and connectors between system components. It is
important that you use Apple peripheral devices and shielded cables and connectors between
system components to reduce the possibility of causing interference to radios, television sets,
and other electronic devices. You can obtain Apple peripheral devices and the proper shielded
cables and connectors through an Apple-authorized dealer. For non-Apple peripheral devices,
contact the manufacturer or dealer for assistance.
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DOC statement
DOC Class B Compliance This digital apparatus does not exceed the Class B limits for radio
noise emissions from digital apparatus as set out in the interference-causing equipment standard
entitled “Digital Apparatus,” ICES-003 of the Department of Communications.

Observation des normes—Classe B Cet appareil numérique respecte les limites de bruits
radioélectriques applicables aux appareils numériques de Classe B prescrites dans la norme 
sur le matériel brouilleur : “Appareils Numériques,” NMB-003 édictée par le ministre des
Communications.

VCCI statement

Laser information
WARNING Making adjustments or performing procedures other than those specified in your
equipment’s manual may result in hazardous exposure.

WARNING Do not attempt to disassemble the cabinet containing the laser. The laser beam used in
this product is harmful to the eyes. The use of optical instruments, such as magnifying lenses,
with this product increases the potential hazard to your eyes. For your safety, have this
equipment serviced only by an Apple-authorized service provider. 

Your CD-ROM drive is a Class 1 laser product. The Class 1 label, located on the drive,
indicates that the drive meets minimum safety requirements. 
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Your AppleCD 600e quad-speed CD-ROM player works with the Macintosh
IIci computer and all later Macintosh and PowerBook models that have a
68030 or higher processor with a clock speed of 25 megahertz or higher. Your
system software must be version 7.1 or later. If you have any questions about
whether the AppleCD 600e is compatible with your computer, contact an
Apple-authorized dealer or service provider.

To begin, remove the CD-ROM player from its packing materials. Then
follow the steps in this chapter to set up the player.

Make sure you have the correct cable to connect the player

The AppleCD 600e CD-ROM player is a SCSI (Small Computer System
Interface) device, which connects to the computer through a SCSI port. You
can connect the player directly to your computer’s SCSI port; or, if you have
other SCSI equipment (such as printers, hard drives, or scanners), you can
connect the player to another SCSI device in a SCSI chain.

The type of cable you use depends on whether you are connecting the player
to the computer or to another SCSI device.

1
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m If you are connecting the CD-ROM player to a computer with no other
external SCSI devices, you need a SCSI system cable.

m If you are adding the CD-ROM player to an existing SCSI chain, you need
a SCSI peripheral cable.

m If you are connecting the CD-ROM player to a PowerBook computer, you
need an HDI-30 SCSI system cable.

If your SCSI devices are more than 3 feet apart, you can attach SCSI cable
extenders. SCSI cables, SCSI cable terminators, and cable extenders are
available from an Apple-authorized dealer or service provider.

HDI-30 SCSI system cable

SCSI system cable

SCSI peripheral cable
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Do you need a SCSI cable terminator?

SCSI cable terminators ensure the accuracy of information passing through
the SCSI chain. A chain of SCSI devices must have two and only two
terminators. Follow these guidelines to determine if you need terminators:

m If you are connecting the CD-ROM player to an existing SCSI device or
chain that is working properly, you need no additional terminators.

m If you are connecting the CD-ROM player by itself to a Macintosh IIci
without an internal hard disk or to a PowerBook, you need two
terminators.

m If you are connecting the CD-ROM player by itself to any other model, you
need one terminator.

For more information, see “Connecting to an Existing SCSI Chain” in the
section “Connecting the Apple CD 600e CD-ROM Player to Your Computer”
later in this chapter.

SCSI cable terminator



Connecting the power cord to a power supply

A power cord comes in the box with your CD-ROM player. To connect the
power cord:

1 Make sure the CD-ROM player is turned off.

2 Plug the socket end of the power cord into the recessed power cord receptacle on the
back of the CD-ROM player.

3 Plug the other end of the power cord into a grounded AC outlet.

WARNING This equipment is intended to be electrically grounded. Your
external CD-ROM player is equipped with a three-wire grounding
plug—a plug that has a third (grounding) pin. This plug will fit only a
grounded AC outlet. This is a safety feature. If you are unable to insert
the plug into the outlet, contact a licensed electrician to replace the
outlet with a properly grounded outlet. Do not defeat the purpose of the
grounding plug!
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Setting the SCSI ID number

Each external device in a SCSI chain must have a unique ID number between
1 and 6. The CD-ROM player’s SCSI ID number is preset to 3. If you have
another SCSI device with the ID number 3, you need to change one of the
numbers.

To change the SCSI ID number of the CD-ROM player:

1 Make sure the CD-ROM player is turned off.

2 Choose a number between 1 and 6 that is not assigned to any other SCSI device
connected to your computer.

The number does not need to match the device’s position in the SCSI chain.

3 Set the ID switch on the back panel of the player to the desired number.

Pressing the lower button makes the number higher and pressing the upper
button makes the number lower.

SCSI ID switch

WARNING Using two or more devices with the same ID number can
cause your equipment to malfunction. You could lose data as a result.
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Connecting the AppleCD 600e CD-ROM player to your computer

If you are connecting the CD-ROM player to a computer with no other external
SCSI devices, follow the instructions in the next section.

If you are adding the CD-ROM player to an existing SCSI chain, go to
“Connecting to an Existing SCSI Chain,” later in this section.

Connecting to a computer with no other external SCSI devices

1 Make sure your computer and your CD-ROM player are plugged in and turned off.

2 Attach the SCSI system cable to the SCSI port (marked by g) on your computer and
tighten the screws on the connector.

If you’re connecting the CD-ROM player to a PowerBook, you need an HDI-30
SCSI system cable, which looks different from the cable shown here.

3 Plug the other end of the SCSI system cable into a port on the player’s back panel. Snap
the wire clips into the brackets.

If you’re connecting the CD-ROM player to a PowerBook or to a Macintosh IIci
with no internal hard disk, first plug a SCSI cable terminator into the SCSI
system cable and then connect the terminator to the player.

Tighten the thumbscrews gently.
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4 Plug a SCSI cable terminator into the other port on the back panel and fasten the wire
clips.

If you’re connecting the CD-ROM player to a Macintosh IIfx, you must use the
black SCSI cable terminator that came with your computer.

Connecting to an existing SCSI chain

You can connect up to six external SCSI devices in a chain. The total cable
length cannot exceed 20 feet. (Apple SCSI peripheral cables are designed to
meet this specification.)

You can connect the CD-ROM player anywhere in an existing SCSI chain,
unless the last device in the chain has a built-in terminator.

IMPORTANT You should not use more than two terminators in a SCSI chain,
or your equipment will not work properly. If an external device has a built-in
terminator, it should go at the end of the SCSI chain. (Check the manual that
came with the device. Most external SCSI devices from Apple do not have
built-in terminators.) If you have more than one external device with a 
built-in terminator, an Apple-authorized dealer or service provider can
remove the extra terminators.

To secure the connection, snap 
the diamond-shaped wire clips 
into place.

SCSI terminator

SCSI system cable
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Connecting the CD-ROM player in the first position of a SCSI chain

1 Make sure your computer and all external SCSI devices are plugged in and turned off.

2 Unplug the SCSI system cable from the first device in the chain.

3 If necessary, attach a SCSI cable terminator to the SCSI system cable.

If you are connecting to a Macintosh IIci without an internal hard disk, or if you
are connecting to a PowerBook, you must attach a SCSI cable terminator to the
end of the system cable. Otherwise, go to step 4.

4 Plug the SCSI system cable (or terminator) into a port on the back panel of the CD-ROM
player.

5 Plug a new SCSI peripheral cable into the remaining port on the back panel of the player.

6 Plug the other end of the SCSI peripheral cable into the next device in the chain.

Desktop computer

g
CD-ROM player

SCSI system cable SCSI peripheral cable

SCSI terminator

8 Chapter  1



9Set t ing Up the AppleCD 600e Quad-Speed CD-ROM Player

Connecting the CD-ROM player between two devices in a SCSI chain

No additional SCSI cable terminators are required for this connection.

1 Make sure your computer and all the other SCSI devices are plugged in and turned off.

2 Unplug one end of the SCSI peripheral cable to which you wish to connect the CD-ROM
player.

3 Plug the cable into a port on the back panel of the CD-ROM player.

4 Plug a new SCSI peripheral cable into the remaining port on the back panel of the player.

5 Plug the other end of the new SCSI peripheral cable into the SCSI device you
disconnected.

Desktop computer

g

SCSI system cable

CD-ROM player

SCSI peripheral cables

SCSI terminator



Connecting the CD-ROM player in the last position of a SCSI chain

If the device at the end of the chain has a built-in terminator, do not place the
CD-ROM player at the end of the chain. Check the manual that came with the
device to find out whether it has a built-in terminator. (External devices from
Apple Computer usually do not have built-in terminators.)

1 Make sure your computer and all SCSI devices are plugged in and turned off.

2 Remove the terminator from the SCSI device at the end of the chain.

3 Plug a new SCSI peripheral cable into the available SCSI port on the device.

4 Plug the other end of the peripheral cable into a port on the back panel of the CD-ROM
player.

5 Plug the terminator into the remaining port on the back panel of the player.

Desktop computer

g

SCSI system cable

CD-ROM player

SCSI peripheral cable

SCSI terminator

10 Chapter  1



Installing the CD-ROM software

The software you need to install to use the CD-ROM player is on the
CD-ROM Setup disc that came with your external CD-ROM player. The
CD-ROM disc is a special disc called a bootable CD. You can start up from
the CD-ROM Setup disc to install your CD-ROM player software. Follow the
steps in this section.

1 Turn on your CD-ROM player by pressing the on/off switch on the back panel.

If other SCSI devices are connected to your computer, turn them on also.

2 Press the Open/Close button of the external CD-ROM player to open the tray.

The tray opens.

3 Place the CD-ROM Setup disc in the tray, with the disc label facing up.

Hold the disc by the edges, or by one edge and the center hole. The disc label
should face up and the disc should lie flat in the tray.

Open/Close button
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4 Push the tray in, or press the Open/Close button, to close the tray.

5 Start up or restart your computer, then quickly press the keys x (Command), Option,
Shift, and Delete on your keyboard.

Hold down all four keys until you see the “happy Macintosh” icon on the
screen.

Holding down these keys tells the computer to bypass the internal hard disk
and to start up from the CD-ROM Setup disc. In a few moments, the disc icon
appears on your screen.

6 Double-click the disc icon to open it.

7 Double-click the Installer icon to open it.

The Install dialog box appears.

12 Chapter  1
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8 Make sure the name of your startup disk is shown in the Destination Disk box. If it is not,
click Switch Disk until the correct disk name appears. 

Your startup disk is the disk whose icon usually appears in the upper-right
corner of your screen.

9 Click Install. 

The CD-ROM and QuickTime software are automatically placed in the
System Folder on the selected disk.

10 When you see a message reporting that installation was successful, click Restart.

Your CD-ROM software has been installed. (If a message reports that
installation was not successful, follow the instructions on screen to try
installing the software again.)

Connecting audio equipment to the AppleCD 600e CD-ROM player

To enhance the sound of audio CDs (music CDs) and music on CD-ROM
discs, you can connect headphones, amplified speakers (such as AppleDesign
Powered Speakers or AppleDesign Powered Speakers II), or a stereo system
to your CD-ROM player or to your computer’s sound output port. You can
also connect headphones to AppleDesign Powered Speakers.
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Connecting headphones

Stereo headphones can be plugged directly into the CD-ROM player. The
headphone jack and volume control are located on the front of the player.

Connecting amplified speakers
Note: If you have AppleDesign Powered Speakers or AppleDesign Powered
Speakers II, see Appendix A for instructions on connecting them.

You can connect amplified speakers to the left and right audio output jacks on
the back panel of the CD-ROM player, or to the headphone jack. (If you
connect to the headphone jack, you use the headphone volume control to
adjust the speaker volume.)

CD-ROM player

Power
supply

Main
speaker

Satellite
speaker
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IMPORTANT You cannot connect ordinary stereo speakers directly to the
CD-ROM player. You must connect amplified speakers or an amplifier to
the player. (You can connect stereo speakers to the amplifier.)

Connecting a stereo amplifier

Connect your amplifier’s audio input cables directly to the left and right audio
output jacks on the back panel of the CD-ROM player. For best performance,
connect a grounding wire from the grounding post on the player to your
amplifier.

Important safety instructions

You’re almost ready to use your CD-ROM player, but first read these
important safety instructions.

For your own safety and that of your equipment, always take the following
precautions.

Disconnect the power plug (by pulling the plug, not the cord) if any of the
following conditions exists:

m the power cord or plug becomes frayed or otherwise damaged

m you spill something into the case

m your external CD-ROM player is exposed to rain or any other excess
moisture

m your external CD-ROM player has been dropped or the case has been
otherwise damaged

m you suspect that your external CD-ROM player needs service or repair

m you want to clean the case (use only the recommended procedure
described later in this section)

CD-ROM player

Grounding post

Aux/CD

Stereo amplifier

Left audio in (white)
Right audio in (red)
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Be sure that you always do the following:

m Keep your external CD-ROM player away from sources of liquids, such as
wash basins, bathtubs, shower stalls, and so on.

m Protect your external CD-ROM player from dampness or wet weather, such
as rain, snow, and so on.

m Keep these instructions handy for reference by you and others.

m Follow all instructions and warnings concerning your system.

m Do not leave the disc tray open. If dust gets on the lens of the CD-ROM
player, the player may have problems reading your compact discs.

m Do not put anything (for instance, a cup) on top of the tray when it is open.

m Do not force the tray open by hand.

m Do not wipe the lens with a paper towel or other abrasive surface. If you
need to clean the lens, see an Apple-authorized service provider for a lens
cleaner.

m Do not transport your computer while a disc is inside the CD-ROM player.

m Keep your computer equipment away from any source of liquid (such as
wash basins, bathtubs, and shower stalls). If you drink coffee or other
beverages while you’re at your computer, take care not to spill.

m Avoid exposing your equipment to damp or wet weather. If your system is
near a window, be sure the window is closed in rainy weather.

WARNING Electrical equipment may be hazardous if misused. Operation
of this product, or similar products, must always be supervised by an
adult. Do not allow children access to the interior of any electrical
product and do not permit them to handle any cables.
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Care and handling

Keep these important safety instructions in mind as you use CD-ROM discs:

m Hold a disc by the edges or by one edge and the center hole. Do not touch
the disc surface.

m To clean discs, wipe the shiny surface with a soft, damp cloth, working in
straight lines from center to edge. Do not use any form of cleaning agent.

m To avoid damage to your discs, follow these guidelines:

m Keep these instructions handy for reference.

m Follow all instructions and warnings concerning your system.

Cleaning

To clean the case, do the following:

1 Disconnect the power plug of the CD-ROM player from the grounded AC outlet. 

2 Wipe the surfaces of the CD-ROM player lightly with a clean, soft cloth dampened 
with water.

Do not put tape
on discs.

Do not scratch
discs.

Do not write on
discs.

Do not spill liquids
on discs.

Do not get
dust on discs.

Do not expose discs
to direct sunlight.
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Your external CD-ROM player for Macintosh computers works with
CD-ROM discs, standard audio compact discs (CDs), and single-session or
multisession Photo CDs. It can also play small (8 cm) CDs. Your CD-ROM
player provides access to large amounts of information. However, you cannot
save information on CD-ROM discs. ROM stands for “read-only memory,”
meaning that the player cannot “write” information onto CD-ROM discs.

A wide selection of CD-ROM discs is available for entertainment, education,
and business. A typical disc can hold more than 650 megabytes (MB) of
information—the equivalent of 270,000 pages of text, up to eight hours 
of speech or music (depending on the sound quality), hundreds of high-
resolution images, or any combination of text, sound, and graphics.

2 Using the AppleCD 600e 
Quad-Speed CD-ROM Player



Types of compact discs you can use

CD-ROM discs store information according to a given file format. Your
computer’s system software must understand the file format to be able to use
the disc.

Standard file formats

You can use CD-ROM discs with these standard file formats:

m HFS (Hierarchical File System)—the standard format used by the
Macintosh.

m ISO 9660—the International Standards Organization’s file format for
CD-ROM discs. This format has been adopted by many CD manufacturers
to make their discs compatible with a variety of computers. It is also the
format that allows you to use Photo CDs in your CD-ROM player.

m The High Sierra format, a predecessor of the ISO 9660 format.

Other CD-ROM formats

Your CD-ROM player also works with file formats other than the ones listed
above (for example, CD-ROM XA), provided that you install the appropriate
software on your Macintosh. See Appendix B for more information on modes
(formats) supported by your player. To find out about Macintosh software for
other file formats, contact the publisher of the disc you want to use.

Audio CDs

Your external CD-ROM player can play audio CDs and audio tracks on 
CD-ROM discs. You can attach headphones or speakers to your player for
stereo sound (see “Connecting Audio Equipment to the AppleCD 600e
CD-ROM Player” in Chapter 1). For further information on audio CDs,
see Chapter 3, “Playing Audio Compact Discs and Audio Tracks on 
CD-ROM Discs.”
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Photo CDs

With your CD-ROM player, you can open digitized images stored on Photo
CDs. To view Photo CD images, you must have QuickTime and Apple Photo
Access installed. (They are installed automatically with the CD-ROM
software. If you need to reinstall them, see “Installing the CD-ROM
Software” in Chapter 1.) For further information on Photo CDs, see Chapter 4,
“Working With Photo CD Images.”

Turning on the CD-ROM player

Once you’ve connected the CD-ROM player to your computer, you must turn
it on in order to use it.

IMPORTANT Be sure to turn on the player and any other SCSI devices before
turning on your computer. If you turn on SCSI devices while the computer is
on, you must restart your computer to allow it to recognize the devices.

To turn on the CD-ROM player:

m Press the on/off switch on the back panel of the player.

When the player is on, you’ll see a green indicator light on the front panel;
the light turns amber when the computer is reading the disc.

On/off switch
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Inserting and ejecting discs

Your CD-ROM player uses a tray to hold a CD-ROM disc in place while a
laser reads information from the disc.

Inserting a disc

Follow these instructions to insert a CD-ROM disc into your CD-ROM
player. Then follow the instructions that came with your disc to use it.

1 Turn on your external CD-ROM player and start up your Macintosh computer.

2 Press the Open/Close button of the external CD-ROM player to open the tray.

3 Place a CD-ROM disc in the tray, with the disc label facing up.

Make sure the disc is lying flat in the tray. If you are inserting a small (8 cm)
disc, be sure it is centered in the tray’s inner ring.

Open/Close button
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4 Push the tray in, or press the Open/Close button, to close the tray.

In a few moments, an icon for the CD-ROM disc appears on your screen.

Ejecting a disc

Follow these instructions to open the tray and eject a CD-ROM disc from
your player.

IMPORTANT With some versions of file sharing software, you cannot eject
a disc if it is being shared. To turn off file sharing, see the manuals or 
on-screen help that came with your computer.

1 Open the tray.

There are several ways to open the tray of your CD-ROM player.

If a CD-ROM disc icon appears on your screen:

m Select the disc icon on your screen and drag the icon to the Trash.

m Click the disc icon, then choose Put Away from the File menu.

m While the AppleCD Audio Player window is active, choose Eject CD from
the File menu, or press x-E. (To learn about the AppleCD Audio Player,
see Chapter 3.)

If you’re using a multivolume disc (which displays more than one disc icon on
your desktop when you insert it), you must put away all of the disc icons to
open the tray.

If no CD-ROM disc icon appears on your screen:

m Press the Open/Close button for your CD-ROM player.

IMPORTANT If you have difficulty opening the tray, see “Problems Using
CD-ROM Discs” in Chapter 5.



2 Take the CD-ROM disc out of the tray.

Store your disc in a safe place, away from heat, dust, and moisture.

3 Push the tray in, or press the Open/Close button, to close the tray.

To avoid possible damage to the tray or the external CD-ROM player, keep the
tray closed when you are not using it.

Turning off the CD-ROM player

To turn off the CD-ROM player:

m Press the on/off switch on the back panel of the player.

When the player is off, the indicator light on the front panel goes off.

Note: The tray of your external CD-ROM player automatically closes when
you shut down your computer. You may want to open the tray and take out
your CD-ROM disc before you turn off the player. Otherwise, the computer
may try to start up from the disc the next time you turn on the computer. For
more information, see “Problems Starting Up Your Computer” in Chapter 5.

If necessary, you can remove a CD from the player while it is off, by inserting
a straightened paper clip into the pinhole next to the player’s tray. For more
information, see “Problems Using CD-ROM Discs” in Chapter 5.

Sharing a CD-ROM disc over a network

You can share a CD-ROM disc using file sharing. If the disc has audio
portions, you will be able to hear the audio yourself, but other people on the
network will not. Likewise, you cannot hear the audio portions of discs you
access over a network.

You cannot copy audio tracks from an audio CD by dragging their icons. The
icons will be copied but can’t be used. However, you can copy audio tracks
from an audio CD using a program that supports QuickTime.

For further information about file sharing, see the documentation or 
on-screen help that came with your computer.
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With your external CD-ROM player, you can play standard audio compact
discs (CDs) as found in music and record stores. To enhance the sound of
audio CDs, you can attach headphones, amplified speakers (such as
AppleDesign Powered Speakers or AppleDesign Powered Speakers II), or an
amplifier to the CD-ROM player or to your computer’s sound output port. See
“Connecting Audio Equipment to the AppleCD 600e CD-ROM Player” in
Chapter 1 for more information.

Playing audio compact discs

Your CD-ROM player comes with a program called AppleCD Audio Player
that lets you start, stop, and otherwise control your audio CDs. You can also
listen to audio in the background while you do other work on your computer.
Before you use the Audio Player program, make sure that the compact disc
contains digital audio information.
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Starting up the AppleCD Audio Player program

To get ready to play an audio CD, follow these steps:

1 Place an audio CD (or a CD-ROM disc with audio tracks) in the tray, with the disc label
facing up.

If you are using a small (8 cm) disc, make sure it is centered in the tray’s
inner ring.

2 Push the tray in, or press the Open/Close button, to close the tray.

In a few moments, the disc icon appears on your screen. An audio CD icon
has the name Audio CD and a number. The icon of a CD-ROM disc shows
the name of the disc.

3 Open the Apple (K) menu and choose AppleCD Audio Player.

The AppleCD Audio Player window appears.

If the AppleCD Audio Player program does not appear in the menu, you must
install it before you can use your external CD-ROM player to play audio CDs
or audio tracks. See “Installing the CD-ROM Software” in Chapter 1.

Using the AppleCD Audio Player program

The AppleCD Audio Player program looks and works like a typical audio CD
player. When you place a CD in the CD-ROM drive, the Audio Player
program sets it to begin with Track 1. You click the Play/Pause button to begin
playing the CD. If you want to select a particular track, you click the Track
buttons. As the disc plays, the Audio Player shows the current track and time
information.

The Audio Player window must be open if you want to start or stop play,
change tracks, or otherwise control play. However, play continues when you
close the Audio Player window.
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Basic controls

Track and time display/Clock button

Shows the track currently being played and time information. There are
several time options: Track Elapsed Time, Track Remaining Time, Disc
Elapsed Time, and Disc Remaining Time. To change the time display, press
the Clock ( ) button. In the pop-up menu that appears, choose an option.
The current option has a checkmark beside it. 

Stop

Stops play and resets the track number to 1.

Keyboard alternative: Press the Delete key or Clear key to stop play.

Play/Pause

Starts or pauses play. Clicking Play (the button with a single arrow on it)
starts play at the beginning of the current track, or resumes play if the Pause
button has been clicked. When the CD is playing, the button changes to Pause
(displaying two small bars), and clicking it pauses play.

Keyboard alternative: Press the Space bar or Enter key to play or pause a
track.
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Eject

Stops play and ejects the CD. (If you are using a multivolume CD, which
displays more than one CD icon on the desktop, you need to click Eject once
for each icon in order to eject the CD.)

Keyboard alternative: Press x-E to eject the disc.

Volume control

Adjusts the volume for the computer’s built-in speaker or for headphones or
speakers attached to the computer. Drag the slider up to increase volume and
down to decrease it. (For the best sound quality, set the control to maximum
and adjust the volume on your headphones or amplifier.)

Keyboard alternative: Press the Up Arrow key to increase volume and the
Down Arrow key to decrease volume.

Scan backward and forward

Moves rapidly backward or forward through a track. You can hear the track as
it scans.

Previous and next track

Moves to the beginning of the previous or next track.

Keyboard alternative: Press the Left Arrow key to move to the previous track
and the Right Arrow key to move to the next track.

Keyboard alternatives

Button Keyboard alternative

Stop Delete  or Clear

Play/Pause Space bar or Enter 

Eject x-E

Volume control Up Arrow (increase) and Down Arrow (decrease)

Previous track Left Arrow

Next track Right Arrow 

Chapter  328



Additional controls

Tracks pop-up menu

Allows you to quickly select and play a track. Press to open the Tracks pop-up
menu; when you choose a track, play begins immediately. (The current track
has a checkmark next to it.)

Repeat

Plays the CD continuously.

Playing modes

You can play audio in one of three modes. To select a mode, click the button
for the one you want. An indicator light shows the current mode.

m Normal plays tracks in order (1, 2, 3, and so on).

m Shuffle plays tracks in random order.

m Program allows you to choose the order for audio tracks. For more
information, see “Creating a Play List,” later in this chapter.

Track Edit button

Displays the Track Edit window, which shows the the name of the disc and
the title, time, and order of tracks.

You can make certain changes to the information in the Track Edit window,
depending on the playing mode selected. The Audio Player program
automatically saves and remembers your changes the next time you use
that disc.
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m In Normal and Shuffle modes, you can change the track and CD titles, but
you can’t change the order of tracks.

m In Program mode, you can change the order of tracks and the title of the
CD, but you can’t change the track titles.

To close the Track Edit window, click the upward-pointing Track Edit button.

Close box

Closes the AppleCD Audio Player. Play continues when the program is
closed.

Options menu

You can adjust some features of the AppleCD Audio Player program using the
Options menu. Each menu item in the Options menu opens a submenu. In the
submenu, the current option is indicated by a checkmark.

m Window color lets you choose a color for the Audio Player window.

m Indicator color lets you choose the color of the indicator lights.

m Sound lets you can change the way you hear the audio. You can choose left
channel only, right channel only, or stereo. This setting affects the built-in
speaker, external speakers, or headphones.

m Startup CD Drive lets you select which CD-ROM player (if you have more
than one) to use with the AppleCD Audio Player. You choose the CD-ROM
player’s SCSI ID number in the submenu that appears.You must close and
reopen the Audio Player for the change to take effect.
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Creating a Play List

You can create a customized Play List for any CD that contains audio tracks.
You choose the tracks you want to play and the sequence in which to hear
them. To create a customized Play List:

1 Click the Program button (labeled PROG).

2 Click the Track Edit button.

The Track Edit window for the Program mode appears.

3 Drag tracks from the Track List at left to the Play List at right. 

Tracks are played in the order they appear in the Play List.

To remove a track from the Play List, drag it back to the Track List.

4 If desired, rearrange the tracks in the Play List by dragging them to new positions.
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5 Click the Track Edit button to close the Track Edit window.

The Play List you create is automatically saved (in the Preferences folder
inside the System Folder). The next time you use this CD in the Program
mode, your Play List will be displayed.

To play a customized Play List:

1 Insert a CD for which you created a Play List.

2 Choose AppleCD Audio Player from the Apple (K) menu.

3 Click the Program button to select Program mode.

4 Click the Play/Pause button.

You will hear the tracks in the order they appear on your Play List.

Another way to play audio tracks

If you open the icon for an audio CD or a CD-ROM disc with audio tracks,
you see audio track icons labeled Track 1, Track 2, and so on. If you select a
track icon and choose Get Info from the File menu, you see the track’s
playing time. You can play a track by opening its track icon.

m Double-click a track icon to start playing it.

IMPORTANT If you drag an audio track icon to a floppy disk or hard disk, the
icon is copied but the copy isn’t usable. However, you can copy audio tracks
using a program that supports QuickTime, such as MoviePlayer.

Closing the AppleCD Audio Player program

You can close the AppleCD Audio Player program and continue with other
work on your computer while the CD plays. There are several ways to close
the program:

m Click the close box in the upper-left corner of the Audio Player window.

m Choose Close from the File menu, or press x-W.

m Choose Quit from the File menu, or press x-Q.

When you want to turn off the CD, change tracks, or change CDs, choose
AppleCD Audio Player from the Apple (K) menu and make the necessary
changes.
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You can use your CD-ROM player to display Photo CD images stored on
Photo CDs. A Photo CD image is a digitized photograph that you can open
and view on your computer screen.
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Obtaining Photo CDs

Your own photographs can be recorded as images on a Photo CD. To obtain a
Photo CD of your own photographs, take your 35-mm film to a photofinisher
who has a Photo CD system. The photofinisher develops your film, digitizes
the photographs, and gives you back a Photo CD containing your images.

A single Photo CD can hold approximately a hundred images. If your Photo
CD isn’t full, you can take it back to the photofinisher and have more photos
added until the disc is full. Such discs are called multisession discs. Your
CD-ROM player can read both single-session and multisession Photo CDs.
(Some older CD-ROM players can read only single-session discs or only one
session of a multisession disc.)

Using Photo CDs

You can do many things with the images on your Photo CDs:

m Open and view the images individually on your computer screen. (See
“Viewing the Contents of a Photo CD,” later in this chapter.)

m View the images on your computer screen one after another, as you would
view a slide presentation. (See “Viewing Several Images in Sequence.”)

m Copy and save the images, print them, paste them into other documents
that accept graphics, and edit them with graphics programs. (See “Working
With Photo CD Images in Other Programs.”)

Photo CD images are excellent for desktop publishing, multimedia
presentations, business documents, and professional-quality graphic design.

IMPORTANT To view Photo CD images, you need QuickTime version 1.6.1 or
later and Apple Photo Access. These files are included when you install all
the CD-ROM software (see Chapter 1). To check the version of QuickTime
you have, locate its icon (in the Extensions folder inside your System Folder),
click the icon to select it, then choose Get Info from the File menu. The
version number appears in the Info window.
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Viewing the contents of a Photo CD

When you double-click a Photo CD file, it is opened by the TeachText or
SimpleText program, unless you select another program to open Photo CD
images. See “Setting Preferences for How Photo CD Images Are Displayed”
later in this chapter.

IMPORTANT If you plan to use TeachText or SimpleText to view Photo CD
images or other large files, you should use the program’s Info window to
assign it more memory. For instructions on assigning memory to a program,
see the documentation or on-screen help that came with your computer.

To view images on a Photo CD:

1 Insert a Photo CD in the CD-ROM player’s tray, with the disc label facing up.

2 Close the tray.

The first time you insert a particular Photo CD, a message appears telling you
the system is creating icons. These icons are tiny representations of the Photo
CD’s contents. Click Stop if you want to use generic document icons instead.

After a few moments, an icon for the Photo CD appears on the desktop. The
disc name has the letters “PCD” and an identifying number supplied by the
photofinisher. You cannot change the name of the disc.

By the way: If you choose generic document icons and later decide you want
Photo CD icons instead, you can create them by pressing x-Option as you
insert the Photo CD. Continue holding down the keys until the disc icon
appears.
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3 Double-click the disc icon to open the Photo CD window.

A Photo CD window always contains a Slide Show, the Slide Show Viewer,
and a Photos folder. The Slide Show is a QuickTime movie that contains
all your images. For more information, see “Viewing Several Images in
Sequence,” later in this chapter. The Photos folder holds your individual
images.

The Photo CD window also contains a PHOTO-CD folder that holds
technical information about your Photo CD images. Normally, you won’t need
to use this folder.

4 Double-click the Photos folder to open it.

The Photos folder contains five folders. Each folder contains all your Photo
CD images recorded at a particular resolution. (See “A Note About
Resolution” later in this chapter.)
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5 Double-click the folder for the resolution you want.

Within the folder, an icon appears for each Photo CD image. Each icon is a
tiny representation of the image the file contains. The image numbers
correspond to the index that comes with your Photo CD.

IMPORTANT When your system is low on memory, your computer may not be
able to display color icons for your Photo CD images; however, the images
themselves are not affected. To see the color icons, quit all open programs,
restart your computer, and then reopen the Photos folder. See the
documentation or on-screen help that came with your computer for more
information on managing memory.
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6 Double-click the icon of the image you want to see.

The image appears in a TeachText or SimpleText window. (You can choose to
have Photo CD images opened by another program. See “Setting Preferences
for How Photo CD Images Are Displayed” later in this chapter).

You can view and print the image, or paste it into your Scrapbook or into a
document created by another program that can handle graphics.

IMPORTANT You can’t rename or change the Photo CD images on the
CD-ROM disc. To rename or change an image, you first need to copy it to
a hard disk or floppy disk.
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Viewing several images in sequence

You can browse through all your Photo CD images using the Slide Show and
the Slide Show Viewer in the Photo CD window. The Slide Show is a
QuickTime movie of all your Photo CD images.

To play the Slide Show:

1 Insert a Photo CD and open the Photo CD window.

2 Double-click the Slide Show icon.

The Slide Show Viewer automatically begins displaying Photo CD images.

3 Use the Slide Show Viewer controls to stop or start the slide show, scroll to particular
images, or move forward or backward through the images.

You can also go directly to an image by typing its number.
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Setting preferences for how Photo CD images are displayed

You can control how Photo CD images are displayed by using the Preferences
command in the Slide Show Viewer. You can choose:

m which program will automatically open Photo CD images

m which resolution is used

m the size of the Slide Show window

To set your preferences for viewing Photo CD images:

1 Double-click the Slide Show Viewer icon to open it.

2 Choose Preferences from the File menu.

The Preferences dialog box appears.

IMPORTANT You may see an error message when you choose a program for
opening Photo CD images. The message indicates that you can’t open an
image in this program by double-clicking the image. However, you may be
able to open an image from within the program, using its Open command.
(See the documentation that came with your program for more information.)

3 After you’ve chosen the options you want, click OK to close the Preferences dialog box. 

4 Restart your Macintosh.

After you restart your Macintosh, double-clicking a Photo CD image will
open it in the selected program at the specified resolution and size.
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A note about resolution

When a Photo CD image is created, it’s recorded at five different levels of
resolution. The higher the resolution, the more information is recorded about
the image, and the sharper the image appears when displayed or printed at
larger sizes. However, high-resolution images take up a lot of memory—up to
18 MB of data for one photograph—which affects file size, as well as the
amount of time it takes to display or print an image.

It’s best to work with a resolution appropriate for your monitor or printer.
Some monitors and printers cannot display or print very high-resolution
images.

For most work, a resolution of 768 x 512 pixels or smaller is suitable. For
detailed work or very high-quality reproductions, you may want to use a
higher resolution.

Make sure to open high-resolution images with application programs designed
to handle large image files. TeachText and SimpleText cannot open very
large files.

Working with Photo CD images in other programs

There are several ways to open and work with Photo CD images in other
programs:

m You can choose a program that automatically opens a Photo CD image
when you double-click it. See “Setting Preferences for How Photo CD
Images Are Displayed,” earlier in this chapter.

m From the Slide Show Viewer, you can transfer a displayed image directly to
another program, without copying and pasting. See the next section,
“Transferring the Displayed Image to Another Program.”

m You can copy and paste an image. See “Copying Images From a Slide
Show” later in this chapter.

Once you’ve opened an image in a program, you can change the image and
save your changes on a hard disk or floppy disk. (The images on the Photo
CD cannot be changed.)
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Transferring the displayed image to another program

You can transfer an image from the Slide Show Viewer into another program,
using the current Preferences settings or using different settings.

To transfer an image using the current settings in the Preferences dialog box:

m Display the image you want, then choose View from the Photos menu
(or double-click the image).

The image opens in the program and resolution you specified in the
Preferences dialog box.

To transfer the image using different settings:

1 Display the image you want, then choose View As from the Photos menu.

2 In the dialog box that appears, choose a resolution from the Size pop-up menu.

3 From the Using pop-up menu, choose a program to open the image.

If the program you want is not in the pop-up menu, click Add. In the dialog
box that appears, locate and select the program you want to add.

4 When you’ve chosen the options you want, click OK.

The image opens in the program and at the resolution you specified.

Copying images from a Slide Show

You can paste a Slide Show image into any document that accepts images.

To paste an image at the resolution specified in the Preferences dialog box:

1 Display the image you want to copy, then choose Copy from the Edit menu.

2 Open the document you want to paste the image into.
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3 Choose Paste from the Edit menu.

The image appears in your document.

To paste the image at a different resolution:

1 Display the image you want to copy, then choose Copy As from the Edit menu.

2 In the dialog box that appears, choose a resolution from the Size pop-up menu.

3 Click OK.

4 Open the document you want to paste the image into.

5 Choose Paste from the Edit menu.

The image appears in your document.

Copying a Slide Show onto another disk

You can copy the Slide Show to a hard disk or floppy disk.

IMPORTANT You can’t copy a Slide Show by dragging its icon. The icon will
be copied, but you won’t be able to use it to view the Slide Show.

To copy the Slide Show:

1 Double-click the Slide Show icon to open it.

2 Choose Save a Copy from the File menu.

The Compression Settings dialog box appears.

3 Select the options you want.

You can copy either color or grayscale images. You can specify a compression
method and the quality of the copy.

4 Click OK.

A dialog box appears.

5 Choose a location and type a name for the copy, then click Save.

You can now open your disk copy of the Slide Show to view the Slide Show.
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This chapter describes solutions to problems you may encounter while using
your external CD-ROM player.

Many problems can be caused by improper installation of the CD-ROM
software. If you need to reinstall the software, make sure you install it exactly
as described in the section “Installing the CD-ROM Software” in Chapter 1.

If the suggestions in this chapter don’t solve your problem, refer to the service
and support information that came with your computer for information on
obtaining technical assistance.

Problems starting up your computer

The computer doesn’t seem to know that there is an external CD-ROM player.

m Make sure the CD-ROM player is properly connected and turned on. Make
sure the software that came with your CD-ROM player is installed. Be sure
to restart your computer after installing the software. See Chapter 1 for
information on connecting your player and installing software.

m If you have other SCSI equipment attached to your computer, make sure
that each device has a unique SCSI ID number between 1 and 6. See the
manuals that came with your SCSI equipment if you need to reset SCSI ID
numbers. See Chapter 1 for information on attaching SCSI equipment.

m Be sure to start or restart the computer after turning on your SCSI
equipment (or else the computer cannot recognize the SCSI equipment).
Be sure to turn on all SCSI devices connected to your computer.
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The computer won’t restart after you’ve copied software for your CD-ROM player to the
System Folder.

m If you attempt to install software for your CD-ROM player without using
the Installer, you may not be able to restart your computer. Restart the
computer with the Shift key held down (to turn off system extensions), then
remove any CD-ROM software files you copied by dragging them to the
Trash. Reinstall the software according to the instructions in Chapter 1.

If using the Shift key doesn’t work, restart the computer using another
startup disk. (For instructions, see your computer’s documentation or 
on-screen help.)

Your computer won’t restart and there is a CD-ROM disc inside the CD-ROM player.

m Your computer may be trying to start up from the CD-ROM disc. Press
the Open/Close button on the player to open the tray, and remove the
CD-ROM disc. Then restart your computer.

To avoid having the computer start up from a CD-ROM disc, remember to
remove any disc in the player before you shut down your computer.

When your computer starts up, you see large folder-shaped areas, containing labeled
pictorial buttons, instead of the usual Macintosh desktop.

m Your computer may have started up from a CD-ROM disc containing
At Ease, an alternative to the Macintosh desktop. To return to the
Macintosh desktop, choose Shut Down from the Special menu. Press the
Open/Close button on your CD-ROM player to open the tray, then remove
the disc. Close the tray, then start up your computer again.

Problems using CD-ROM discs

The tray of your CD-ROM player won’t open.

If a CD-ROM disc icon appears on your screen:

Drag the disc icon to the Trash, or select it and choose Put Away from the
File menu. If the AppleCD Audio Player is active, choose Eject CD from the
File menu. (If you are using a multivolume CD, which displays multiple icons
on the desktop, you need to put away all the icons to open the tray.)

46 Chapter  5



If you see a message that a disc can’t be put away because it is being shared,
turn off file sharing, then try putting away the disc. (See your computer’s
documentation or on-screen help for information on file sharing.)

If no CD-ROM disc icon appears on your screen:

m Press the Open/Close button of your external CD-ROM player.

m The signal to open the tray may not be reaching the player. Turn off your
computer and player. Locate the small pinhole to the lower right of the
CD-ROM tray opening. Insert the end of a large straightened paper clip
horizontally into the pinhole. Push gently but firmly until the tray is
released, then carefully pull the tray open. Do not force the tray open; wait
until the paper clip has dislodged it, or you may break the front of the tray.

If neither of these suggestions works, your CD-ROM player may be damaged.
Contact an Apple-authorized service provider or Apple.

You insert a CD-ROM disc, but its icon doesn’t appear on the Macintosh desktop. 

m Make sure the disc label is facing up and the disc is centered in the tray.

m Make sure the tray is closed all the way.

m Make sure the CD-ROM software is installed. (See Chapter 1.)

m Try restarting your computer.

Your computer displays the message “This is not a Macintosh disk: Do you want to
initialize it?” when you insert a CD-ROM disc in the CD-ROM player. 

m Make sure the CD-ROM software is installed. (See Chapter 1.)

m Turn off any utility programs you’re using that allow you to work with
non-Macintosh disks.

m The disc may use an information format (mode) that the Macintosh cannot
recognize. (See the section on modes in Appendix B.)

WARNING Turn off your computer and CD-ROM player before you
attempt to open the tray using a paper clip. If you don’t, you may
damage the CD-ROM player.
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Your computer ejects a CD-ROM disc without giving you any error message. 

m Make sure the disc is flat and centered in the tray and the disc label is
facing up.

m The disc may need to be cleaned. (See “Care and Handling” in Chapter 1.)
If there are visible scratches on the shiny side of the disc, you may be able
to remove them with a CD polishing kit (available from your audio CD
dealer). If the scratches can’t be removed, you’ll need to replace the disc.

m The disc may be damaged. Try another disc in your CD-ROM player, or try
the problematic disc in another player. If the original player reads other
discs, or if the problematic disc doesn’t work in another player, the disc is
probably damaged. You’ll need to replace the disc.

You can’t open a document on a CD-ROM disc.

m Try opening the application program first; then open the document using
the program’s Open command.

m Consult the documentation that came with your disc. Some discs come
with software that you need to install on your computer before using them.

You can’t save changes you make to information on a CD-ROM disc. 

m CD-ROM is a read-only medium. This means that information can be read
(retrieved) from it, but not written (stored) on it. You can save the changed
information on a hard disk or floppy disk.

You can’t use your old CD-ROM player. 

m The CD-ROM software installed with your new CD-ROM player is
designed to let you use more than one CD-ROM player at a time. However,
you will not be able to use your old CD-ROM player if an old version of
the Apple CD-ROM driver remains in your System Folder. This may
happen if you renamed the driver. Remove the old CD-ROM driver from
the Extensions folder (inside the System Folder), and restart your
computer. To make sure that you’re removing the correct file, select it and
choose Get Info from the File menu. The Info box will include the name
“Apple CD-ROM” and the version number will be lower than 5.0.
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Problems using ISO 9660 or High Sierra discs

You can’t access files on a CD-ROM disc that uses the ISO 9660 or High Sierra format.

m Discs in the ISO 9660 and High Sierra disc formats have version numbers
attached to filenames. Some application programs need these version
numbers in order to work with files. To make the version numbers
available to programs on your computer, follow these instructions:

Drag the disc icon to the Trash. After the tray opens, hold down the Option
key and close the tray. Hold down the Option key down until the tray is
completely closed. The program should now be able to locate filenames on
the disc.

Problems playing audio CDs

You don’t hear any sound when you play an audio CD or an audio track on a CD-ROM
disc using the AppleCD Audio Player program.

m On some models, you cannot hear audio CD sound if equipment
(other than headphones or speakers) is plugged into the computer’s sound
output port.

m If you are using a CD-ROM disc over a network, you won’t be able to hear
the audio portion.

m If you are using headphones or speakers, make sure they are firmly
connected. Adjust the volume control on your headphones or speakers.

m Adjust the volume in the AppleCD Audio Player program. (With the Audio
Player window open, drag the volume control slider up.)

m Make sure the CD is playing. (With the Audio Player window open, click
the Play/Pause button or press the Space bar on your keyboard.)
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While playing an audio track on a CD-ROM disc that combines audio tracks and data,
you double-click the disc icon and the audio track stops playing.

m You can’t open data files on a CD-ROM disc and listen to audio tracks on
that disc at the same time.

You are unable to record sound from an audio CD.

m See if a microphone or other device is connected to the computer’s sound
input port. On some models, a device connected to the sound input port
may turn off the computer’s ability to record from an external CD-ROM
player.

Problems using Photo CDs

Your CD-ROM player will not open Photo CDs.

m To view Photo CD images, you must have QuickTime (version 1.6.1 or later)
and Apple Photo Access installed in your System Folder. Reinstall all the
CD-ROM software. (See Chapter 1).

Your computer does not display color icons for individual images on a Photo CD.

m Your system may be low on memory. To view color icons, restart your
computer, then reopen the Photos folder. See the documentation or on-
screen help that came with your computer for more information on
managing memory.

A Photo CD image is scrambled, colors are displayed incorrectly, or no image appears.

m The program you are using may not be designed to work with large (high-
resolution) image files. Try opening the image at a lower resolution,
opening the image with another program (see “Setting Preferences for
How Photo CD Images Are Displayed” in Chapter 4), or assigning more
memory to the program (see your computer’s documentation or on-screen
help).
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After you open a Photo CD image, your system “freezes” and does not respond to any
input, or a “bomb” message appears on your screen.

m Restart your Macintosh. The program you are using may not be designed
to work with large (high-resolution) image files. Try opening the image at a
lower resolution, opening the image with another program (see “Setting
Preferences for How Photo CD Images Are Displayed” in Chapter 4), or
assigning more memory to the program (see your computer’s
documentation or on-screen help).

WARNING If you have a problem with your CD-ROM player and nothing
presented in this chapter solves it, consult the service and support
information that came with your computer for instructions on how to
contact an Apple-authorized service provider or Apple for assistance. If
you attempt to perform upgrades or repairs yourself, any damage you
may cause to your equipment will not be covered by the limited
warranty on your equipment. Contact an Apple-authorized dealer or
service provider for information about this or any other warranty
question.
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If you wish to connect AppleDesign Powered Speakers or AppleDesign
Powered Speakers II to your CD-ROM player, follow the instructions in this
appendix.

You can connect your speakers to a computer or to a separate CD player,
cassette tape deck, or radio. The speakers are designed for personal listening,
and they give you a full range of crisp highs, clear midranges, and rich bass.
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Using AppleDesign Powered Speakers

Before you connect the speakers, make sure you have the items that came
with the AppleDesign Powered Speakers.

Main speaker

Power supply

CD stereo cableComputer connection cable

Speaker-to-speaker cable

Satellite speaker

R L
15V

CD

DC
IN

Computer
port

Power port
CD stereo

cable jacks

Subwoofer
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Connecting the speakers

Use the following diagrams to help you set up your speakers. When you use
the CD stereo cable, make sure you connect the audio jacks properly, right to
right and left to left.

Turning on the speakers

1 Plug the power supply into an AC outlet.

2 Make sure the volume control (Ï) on the main speaker is turned down.

3 Press the power button (I) on the front of the main speaker. 

The power indicator light glows green when the power is on.

Follow the instructions in Chapter 3 to play audio CDs and audio tracks on
CD-ROM discs.

Macintosh computer

Computer
connection cable

Sound output portCD stereo cable

Speaker-to-speaker cable

Power
supply

CD-ROM player

WARNING Do not connect other speakers to the AppleDesign main
speaker. Do not connect your AppleDesign speakers to the speaker
output of a stereo system amplifier, or you may damage your speakers.
You can connect your AppleDesign speakers to the monitor output of
an audio amplifier.
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Adjusting the volume and balance

There are three ways to adjust volume (Ï) and balance (+) on your
speakers.

m To adjust overall sound volume and balance, use the controls on the front
of the main speaker.

m To adjust the sound produced by an audio CD or an audio track on a 
CD-ROM disc in your player, use the AppleCD Audio Player program (see
Chapter 3).

m To adjust the sound produced by your computer, use your computer’s
Sound control panel (see your computer’s documentation or on-screen
help).
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Using AppleDesign Powered Speakers II

Before you connect the speakers, make sure you have the items that came
with the AppleDesign Powered Speakers II.

CD stereo cable

Computer connection cable

Power supply

Main speaker

Speaker-to-speaker cable
(connects to main speaker)

Satellite speaker

Headphone jack Volume control

CD port

Computer port

Satellite
speaker port

Power port
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Connecting the speakers

Use the following diagram to help you set up your speakers:

Follow the instructions in Chapter 3 to play audio CDs and audio tracks on
CD-ROM discs.

CD stereo cable Sound output port
Speaker-to-speaker

cable

Power
supply

Main
speaker

ComputerSatellite
speaker

Computer connection cable

CD-ROM player

WARNING To prevent damage to your main speaker, do not connect
speakers other than the AppleDesign satellite speaker to the main
speaker. Do not connect the speakers to an external amplifier.
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Adjusting the stand

You can adjust the tilt of the AppleDesign Powered Speakers II by sliding the
stand up or down.

Using headphones with your speakers

You can use headphones with both the AppleDesign Powered Speakers and
the AppleDesign Powered Speakers II. You can plug most types of
headphones into the headphone jack on the front of the main speaker. When
you plug in the headphones, you only hear sound through the headphones. To
adjust balance and volume for your headphones, use the controls on the front
of the main speaker.

IMPORTANT Don’t remove the stand from the speaker.
(If you remove the stand, the quality of the speaker’s
sound will be impaired.)
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Troubleshooting

The speakers produce weak sound or no sound.

m Make sure the power supply is securely connected at both ends.

m If you have the original AppleDesign Powered Speakers, make sure the
speakers are on. The power indicator light glows green when the power
is on.

m Make sure your computer is on.

m Make sure all cables are securely connected to the proper jacks.

m Adjust the volume controls on your CD-ROM player, on the main speaker,
on the AppleCD Audio Player program, and in your computer’s Sound
control panel.

One speaker doesn’t produce sound.

m Make sure the speaker-to-speaker cable is securely connected at both ends.

m If you have the original AppleDesign Powered Speakers, adjust the balance
control.

The speakers produce weak bass sound.

m If you have the original AppleDesign Powered Speakers, make sure the
speaker-to-speaker cable is properly connected to the main and satellite
speakers, with the black and gray wires going to the correct terminals. If
the wires are reversed, the sound will be weak or distorted.
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Data streaming and transfer rates

m Blocks per second

Normal speed 75

Double speed 150

Quadruple speed 300

m User kilobytes (K) per second

Normal speed 150K, Mode 1

171.1K, Mode 2

Double speed 300K, Mode 1

342.2K, Mode 2

Quadruple speed 600K, Mode 1

684.4K, Mode 2

m SCSI bus burst rate (typical)

Asynchronous 5.0 megabytes (MB) per second

Synchronous 5.0 MB per second

m Latency (average) Varies over radius

Normal speed ~55 to 130 milliseconds (ms)

Double speed ~27.5 to 65 ms

Quadruple speed ~13.75 to 32.5 ms
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m Random access time (typical)

Normal speed < 410 ms

Double speed < 295 ms

Quadruple speed < 200 ms

m Random seek time (often called “access time”)

Normal speed 280 ms

Double speed 230 ms

Quadruple speed 167.5 ms

Modes supported

m Audio CD

m CD-ROM Modes 1 and 2

m CD-ROM XA Mode 2, Forms 1 and 2

m CD+I Mode 2, Forms 1 and 2

m Photo CD Single session and multisession

m Video CD

m CD+MIDI

m CD+G

Laser

m Type

Semiconductor GaAlAs laser

m Wavelength

790 ± 25 nanometers

m Output power

0.14 milliwatts

m Beam divergence

53.5 ± 1.5°
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Disc

m Data surfaces 1

m Disc diameter 120 millimeters (mm) and 80 mm

m Disc center hole diameter 15 mm

m Thickness 1.2 mm

m Track pitch 1.6 microns (15,875 tracks per inch)

m Scanning velocity 1.2–1.4 meters per second

m Rotation speed Varies over radius

Normal speed ~530 to 230 revolutions per minute (rpm)

Double speed ~1060 to 460 rpm

Quadruple speed ~2120 to 920 rpm

m Blocks per rotation ~8.4 to 19.5 variable

Data

m Data capacity 656 MB, Mode 1

748 MB, Mode 2

m Number of blocks per disc 336,150

m Data per block 2048 bytes, Mode 1

2336 bytes, Mode 2

m Address description Minutes, seconds, blocks

Audio capacity

m Playing time 74 minutes and 42 seconds
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Environmental

Noise (maximum)

m Drive on (seek) < 50 decibels (dB) 

m Drive on (non-seek) < 46 dB

m Tray open/close < 55 dB

Temperature

Celsius (C) and Fahrenheit (F)

m Operating temperature 5° to 40° C (41° to 104° F)

m Storage (6 months) –30° to 50° C (–22° to 122° F)

m Transient (72 hours) –40° to 65° C (–40° to 149° F)

Humidity

m Operating 5% to 90% noncondensing

m Storage 5% to 95% noncondensing

Altitude

Meters (m) and feet (ft.)

m Operating –305 to 3048 m

(–1000 to 10,000 ft.)

m Shipping, non-operating –305 to 15,240 m 

(–1000 to 50,000 ft.)

Power requirements

m 100-240 V

m 50/60 Hz

m 0.28-0.17 Amp
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AppleCD Audio fPlayer program
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keyboard alternatives  27, 28
modifying features in  30
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starting  26
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“bomb” message  51
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CD-ROM tray
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CD-ROM discs; Photo CDs

chain of SCSI devices  1–3, 6–9
cleaning the CD-ROM player  17
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window  27
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window  29, 30
closing the AppleCD Audio Player

program  32
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compact discs. See audio CDs; CD-ROM
discs; Photo CDs

computer
connecting to CD-ROM player

1–3, 5–10
“frozen”  51
installing CD-ROM software on

11–13
problems starting  45–46
system software required for  1

connecting
AppleDesign Powered Speakers

54–55
AppleDesign Powered Speakers II  58
amplified speakers  14–15
audio devices  13–15
CD-ROM player to computer

1–3, 6–10
headphones  14, 59

connectors  2
copying

audio tracks  32
Photo CD images  38
Slide Show to disk  43

cord. See power cord

D

damage to CD-ROM player  15, 16
data streaming and transfer specifications

61–62
Delete key, as Stop button alternative

27, 28
digitized images  21
disc icon. See CD-ROM disc icon
discs. See audio CDs; CD-ROM discs;

Photo CDs
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document
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won’t open  48

E
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window  27, 28
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alternative  27, 28
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external CD-ROM player. See

CD-ROM player

F

FCC statement, vi
file formats for CD-ROM discs  20
file sharing

with CD-ROM discs  23, 24
problems with  47

Foreign File System  11
“frozen” system  51

G

graphics files, memory requirements 
for  35

green indicator light  21
on AppleDesign speakers  55

grounding plug  4
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H

hardware setup. See setup
headphones

connecting  14, 59
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HFS (Hierarchical File System) file
format  20

high-resolution images
printing  41
problems opening  50, 51

High Sierra discs
format  20
problems using  49

I

icons
audio CD  26
CD-ROM disc  23, 47
color, for Photo CD image  37, 50
Photo CD  35

ID numbers for SCSI devices  5
image numbers  39
images, digitized  21. See also 

Photo CD images
indicator light

in AppleCD Audio Player program  30
on CD-ROM player  21, 24
on AppleDesign speakers  55

inserting discs  11–12, 22–23
inserting a Photo CD  35
installing CD-ROM software  11–13. 

See also setup
interference, radio and television  vi
ISO 9660 discs

file format  20
problems using  49

K

keyboard alternatives for audio 
player  27, 28

L

large files, memory requirements for  35
laser information vii
laser specifications  62

M

Macintosh
connecting CD-ROM player to

1–3, 5–10
“frozen”  51
installing CD-ROM software 

on  11–13
problems starting  45–46
system software required for  1

Macintosh IIfx black cable terminator  7
memory

read-only (ROM)  19
and viewing color icons  37, 50, 51
and viewing high-resolution images

35, 50, 51
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“bomb”  51
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microphone  50
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multimedia presentations, Photo CDs 

in  34
multisession discs  34
multivolume CDs, ejecting  28
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N
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on  23, 24

Next track control  27, 28
Normal playing mode  29

O

on/off switch  21, 24
Open/Close button  11, 12
opening the CD-ROM tray  11, 22, 23
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P

pasting Photo CD images  38
peripheral cable, SCSI  2
Photo CD icons  35
Photo CD images  33–43

color icons for  37, 50
controlling  39
copying and pasting  38
copying from a Slide Show  42–43
displaying in other programs  41–42
memory requirements for  35
opening  35
opening automatically  40
printing  38, 41
recording  34
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resolution and  41
scrolling to  39
setting preferences for  40
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Viewer  42
using  34
viewing  35–38
viewing individually  34
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Photo CDs
contents of  21, 33
inserting for the first time  35
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problems using  50–51
uses for  34
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Photo CD window  36
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Photos folder, opening  36
player. See CD-ROM player
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Player program
playing audio CDs  25–32

software for  26
troubleshooting  49–50

playing modes  29
Play List, customizing  31–32
Play/Pause button, in AppleCD Audio

Player window  26, 27
plug, grounded electrical  4
port, SCSI  1, 6
power cord

connecting to power supply  4
frayed  15

powered speakers (AppleDesign)
adjusting stand for  59

adjusting volume and balance on  56
connecting  54–55, 58
troubleshooting  60
using headphones with  59

preferences, setting for Photo CDs  40
Previous track control  27, 28
printing images  38, 41
problems. See troubleshooting
Program playing mode  29
programs. See software

Q

QuickTime software  21, 34
checking version of, 34
installing  11–13

quitting the AppleCD Audio Player
program  32

R

radio interference vi, vii
recording sound, problems with  50
Repeat button, in AppleCD Audio Player

window  29
resizing Slide Show Viewer window  40
resolution of Photo CD images  36

setting options for  41
ROM (read-only memory)  19

69Index



S

safety considerations  vii, 5, 15–16
scanning backward and forward  27, 28
screen display

AppleCD Audio Player 
window  26, 27

Photo CD window  36
scrolling to images  39
SCSI cable terminators  2–3
SCSI chain, adding to  1–3, 7–10
SCSI devices

ID numbers  5
linking  1–2, 7–10
problems with  45
turning on  21

SCSI port  1, 6
SCSI system cables  1–2, 6–10
SCSI terminators  6–10
setup

See also installing CD-ROM software
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57–59
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computer  1–3, 5–10
connecting CD-ROM player to power
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connectors needed for CD-ROM
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ID numbers for SCSI devices  5
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SimpleText program, for viewing Photo
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Slide Show

copying  43

in Photo CD window  36
playing  39
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controls  39
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transferring images  42–43

Small Computer System Interface
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software
installing for CD-ROM player  11–13
for playing audio discs  26
reinstalling  46
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35, 40, 41
system  1
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sound
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program  30
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audio CD  25
Space bar, as Play/Pause alternative
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system “freezes”  51
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television interference vi
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built-in  7
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three-wire grounding plug  5
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window  27
Track buttons, on AppleCD Audio Player

window  26, 27
Track Edit button  29–30, 31
Track Edit window  29–30, 31–32
track icons  32
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Tracks pop-up menu  29
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tray

closing  12, 23, 24
opening  11, 22, 23
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troubleshooting
connecting CD-ROM player  45
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starting up the computer  45–46
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warranty considerations  51
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warranty considerations  51
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